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1. บทนํา 

คําแนะนําในการใชคูมือ 

คูมือฉบับนี้เปนคูมือสําหรับการติดตั้งและใชงาน PS286 PLUS สําหรับคูมือฉบบันี้อางอิงการใชงานรวมกับ Windows XP หรือ 
2000 Professional ซึ่งหากคุณใชวินโดสรุนอื่นๆ หนาจออาจเปลี่ยนแปลงไปบางเล็กนอย  

ในสวนของบทนําในคูมือนี้ จะแสดงถึงรายละเอียดโดยรวมของคูมือแตละหัวขอและอุปกรณที่แนบมากับสินคา ดังนั้นกอนที่
คุณจะทําการติดตั้ง กรุณาตรวจสอบใหแนใจกอนวา มีอุปกรณในกลองครบตามที่บอกไวในคูมือ หากไมครบกรุณาสอบถามจาก
ผูขาย  

ขอควรระวัง 
กอนติดตั้งและใชงาน PS286 PLUS กรุณาอานขอควรระวังดังตอไปนี้ เพื่อปองกันอันตราย อันอาจจะเกิดแกอุปกรณและผูใช 
1.   การลดลงของความชื้นอาจทําใหอุปกรณภายในบางชนิดเสียหาย ซึ่งสาเหตุอาจเกิดจาก 

- เมื่ออุปกรณถูกเคลื่อนยายจากที่รอนไปสูที่เย็น 
- เมื่อหองที่วางอุปกรณรอนขึ้น 
- เมื่ออุปกรณอยูในหองที่มีความชื้นสูง 

เพื่อหลีกเลี่ยงการลดลงของความชื้น  มีคําแนะนําดังนี้ 
-หุมอุปกรณดวยพลาสติก เมื่อสภาพในหองเปลี่ยนแปลงไป 
-รอประมาณ 1-2 ช่ัวโมงกอนจะนําอุปกรณออกจากกระเปา 

2.   ใช AC adapter และสาย USB ที่ใหมากับ PS286 PLUS เทานั้น 
3.   ในกรณีที่คุณตองถอด AC adapter แบบฉับพลัน ใหเหลือพ้ืนที่วางรอบๆ AC adapter  
4.   เก็บสายใหตรง ไมบิดเบี้ยว โคงงอ หรือชํารุด เพราะอาจเปนสาเหตุใหเกิดไฟฟาลัดวงจรได 
5.   ถอดสายอุปกรณเมื่อไมใชแลว 
6.   หามชน เคาะ หรือ กระแทก PS286 PLUS แรงๆ เพราะกระจกและอุปกรณภายในอาจเสียหายได 

ระบบที่แนะนํา 

• PC with Intel Pentium III 1G processor or compatible 
• 256 MB RAM 
• Available USB 2.0 port 
• CD-ROM Drive or DVD-ROM Drive 
• 800 MB Free Hard Disk Space 
• Video card that supports 16-bit color or greater 
• Operating System: Windows 2000 Professional, Windows XP Home Edition, or Windows XP Professional, 

Windows Vista compatible  
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** Systems with Pentium
®
4 1.8G or higher processor (or its compatible), 512 MB RAM and 1GB free hard disk 

space are recommended for optimal performance 
 

อุปกรณในกลอง 

 
1. Scanner  
2. USB Cable  
3. AC Adapter  
4. Stacker  
5. Quick Guide  
6. Setup/Application CD-ROM  
7. Calibration Sheet  
8. Memo Label  
9. Extended Paper Width Slider (2 pieces)  
10. Protection Sheet  
11. Padded Carry Bag 
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สวนประกอบของ PS286 PLUS 
 

1. Paper Chute Cover 
2. Paper Width Slider  
3. Cover Open Lever  
4. Stacker  
5. ADF 
6. Side Guide 
7. Paper Chute Extension 

 
 
 
 
 
 
 
 
 

8. Up Button  
9. Down Button  
10. Function Number Display  
11. Scan Button 
12. Power Led  
 
 
 
 
 
14. Hand Holder  
15. Usb Port  
16. Power Receptor 
17. Power Switch  
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2. การติดต้ัง 

การเชื่อมตอ PS286 PLUS เขากบัเครื่องคอมพิวเตอร 
 

 

ภาพการเชื่อมตอ 

1. เสียบ AC adapter เขากับเครื่องสแกนเนอร 
2. เสียลายอีกขางเขาที่ปลั๊กไฟ 
3. เสียบสายที่ปลายเปนสี่เหลี่ยมจัตุรัสเขากับสแกนเนอร 
4. เสียบสายอีกดานที่เปนสี่เหลี่ยมผืนผาเขากับพอรต USB ของเครื่องคอมพิวเตอร 
5. ถาตองการตอเขากับ USB hub ใหตรวจสอบกอนวา hub ไดเช่ือมตอกับพอรต USB ของเครื่องคอมพิวเตอรเรียบรอย

แลว จากนั้นจึงตอสายสแกนเนอรเขากับ USB hub 
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การติดต้ังไดรเวอร 
1.   เปดสวิตซขางสแกนเนอร 
2.  หากอุปกรณ USB ติดตั้งถูกตอง สแกนเนอรจะถูกคนพบโดยอัตโนมัติ โดยจะขึ้นขอความวา Add New Hardware 

Wizard หรือ Found New Hardware Wizard 
3.   สําหรับ Windows 2000: 

a.   คลิกปุม Next  เมื่ อมีขอความ “Add  New  Hardware  Wizard”  ปรากฏ 
b.   เลือก  Search  for  the  Best  Driver  for  Your  Device  [Recommended]  และคลิกปุมNext 
c.   หนาจอถัดมาจะถามคุณวา จะใหคนหาไดรเวอรจากที่ไหน ใหเลือก  CD- ROM drive และ ไมเลือก Floppy disk drives 

หากมีเครื่องหมายถูกอยูดานหนาขอนี้ 
 
 
 

d.   ใสซีดีรอมที่แนบมาใหกับสแกนเนอร เขาไปในซีดีรอมไดรฟ และคลิกปุม Next  
e.   คลิกปุม Next ในหนาจอถัดมา 
f. ขณะกําลังติดตั้งอาจจะมีขอความ “Digital  Signature  required” ใหขามไปและคลิกที่ปุม  Yes เพื่อทําการติดตั้ง

ตอไป โดยจะไมมีผลกระทบกับการทํางานของสแกนเนอรแตอยางใด หากไมพบขอความนี้ ใหขามไปที่ขอ 4 ไดเลย 
4.   สําหรับ Windows XP: 

a.  ใสซีดีรอมที่แนบมากับสแกนเนอรเขาไปที่ซีดีไดรฟ 
b.   เลือก Install  the  software  automatically recommended และคลิกที่ปุ ม  Next 
c.   เลือกปุม Next ในหนาจอถัดมา จากนั้นขามไปขอ 6 

5. สําหรับ Windows Vista 
a. เลือก “Locate and install driver software (recommended)” เมื่อหนาจอ “Found New Hardware” 
ปรากฏขึ้น 
b. เลือก [Continue] เมื่อหนาจอ “User Account Control” ปรากฏขึ้น 
c. เมื่อมีขอความขึ้นวา “Insert the disc that came with your USB Scanner＂，ใหใสแผนซีดีที่ใหมาพรอม
กับ PS286 PLUS เขาไปในเครื่อง แลวกดปุม Next 
d. หากมีขอความวา “Windows can’t verify the publisher of this driver software” ใหกดปุม Ignore และ
คลิกที่ [Install this driver software anyway] 

6.   คลิกที่ปุม Finish เมื่อติดตั้งเรียบรอย 
7.   ใหทําตามขั้นตอนที่ปรากฏบนหนาจอเพื่อติดตั้งซอฟแวรทั้งหมดที่สแกนเนอรตองการ 
8.   หลังจากติดตั้งซอฟแวรเรียบรอยแลวใหปดโปรแกรมทั้งหมด คลิกที่ปุม Finish เพื่อรีสตารทเครื่อง 
9.   หลังจากที่คอมพิวเตอรรีสตารทแลว สแกนเนอรจะทําการ Calibration 
10. ใสแผน calibration เขาไปใน PS286 PLUS โดยใหลูกศรหันไปทางปุมบนตัวเครื่อง 
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11. ทําตามขั้นตอนที่ปรากฏบนหนาจอ จากนั้นคลิกที่ OK และ Finish 

 
** หากหนาจอการติดตั้งสแกนเนอรไมแสดงอัตโนมัติ ใหคลิกที่ปุม Start เลือก Run และพิมพวา D:\Install (หาก D: เปนซีดี
ไดรฟในเครื่องของคุณ) 

การทดสอบ 

กอนจะทําการทดสอบ กรุณาตรวจสอบใหม่ันใจกอนวาอุปกรณทุกอยางไดตอถูกตองและครบถวนแลว  

ทดสอบการสแกนอัตโนมัติ (ADF scanning) 

1. ใสกระดาษโดยเอาหัวกระดาษลงและคว่ําหนา 
2. คลิกที่ปุม Start เพื่อเปดโปรแกรม Newsoft Presto! Imagefolio 
3. คลิก select source จากเมนูไฟลของ Newsoft Presto! Imagefolio และเลือก PS286 PLUS เปนคาเริ่มตน (แตถาคุณมี 

PS286 PLUS เพียงตัวเดียว ใหขามไปขั้นตอนที่ 4 ไดเลย ) 
4. ในโปรแกรม Presto! Imagefolio คลิกที่ File > Acquire > Acquire 
5. เลือก ADF (Front side) เปนรูปแบบการสแกนใน Twain 
6. คลิกปุมสแกนที่ตัวเครื่อง 
7. เมื่อการสแกนเสร็จสมบูรณ คุณจะเห็นภาพเอกสารที่สแกนบนหนาจอของคุณ 
8. คลิกที่ exit เพื่อออกจากหนาตาง Twain 
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3. การใชงาน 

การตรวจสอบสภาพเอกสาร 
ตรวจสอบขนาด ความหนาและคุณสมบัติอื่นๆของเอกสารวาใชไดกับ PS286 PLUS โดยดูรายละเอียดไดที่ “Specification” ใน

คูมือฉบับนี้ 

การสแกนเอกสารจํานวนมากโดยใช ADF scan จะชวยใหคุณทํางานไดสะดวก รวดเร็ว และงายดายยิ่งขึ้น ADF scan ของ PS286 

PLUS รองรับกระดาษหลากหลายชนิดที่คุณตองใชเปนประจํา เชน 

1. กระดาษธรรมดาที่มีขนาด ความหนาตามรายละเอียดใน “Specification” 
2. กระดาษที่มีรู 
3. กระดาษที่มีการเคลือบผิว เชนโบรชัวรตางๆ 
4. แผนใส (Overhead projector film) 
 

** เพื่อปองกันขอผิดพลาดในการสแกนและความเสียหายแกอุปกรณ กรุณาปฏิบัติดังนี้: 

1. ถอดวัสดุเล็กๆออกกอน เชน คลิปหนีบกระดาษ, เข็มหมุดเล็กๆ, แม็กซ ฯลฯ กอนจะทําการสแกนอัตโนมัติ   
2. ตรวจสอบวากระดาษไมยับหรือพับมุม 
3. หลีกเลี่ยงการสแกนเอกสารทีเขียนดวยดินสอและหนาหนังสือพิมพที่ถูกตัดออกมา เพราะสิ่งเหลานี้จะทําใหกระจก

สแกนและภายในอุปกรณดึงกระดาษอัตโนมัติสกปรก หากคุณจําเปนตองสแกนเอกสารเหลานี้ ใหทําความสะอาด
บอยๆ  

4. ชุดเอกสารที่จะสแกนโดยการสแกนอัตโนมัติ มีความหนา(แกรม) ท่ีตางกันไดแตความยาวตองเทากัน  
 

อยางไรก็ตามใชการสแกนแบบ ADF ในกรณีที่เอกสารเปนดังตอไปนี้ 

1. ความหนาของกระดาษบางกวา  50 g/m2 (14 lb.) หรือ หนากวา 120 g/m2 (32 lb.) 
2. กระดาษที่มีคลิปหรือแม็กซติดอยู  
3. กระดาษที่มีความหนาไมเทากัน เชน ซองจดหมาย 
4. กระดาษที่ยับ มวน โคงงอ ฉีกขาด หรือเย็บเปนเลม 
5. กระดาษรูปทรงแปลกๆ ที่ไมใชสี่เหลี่ยมแบบปกติ 
6. กระดาษลอกลาย หรือสําเนาที่ลอกดวยกระดาษแกว 
7. กระดาษคารบอน, กระดาษก็อปป  
8. วัสดุอื่นนอกจากกระดาษ เชน ผา, ฟรอยด 

 
** หมายเหตุ 
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- ไมใช ADF scan เพื่อสแกนภาพถายหรือกระดาษที่มีรอยยับ เพื่อหลีกเลี่ยงความเสียหายตออุปกรณดึงกระดาษ 
- ไมใสกระดาษที่หมึกยังไมแหงหรือลิควิดเปเปอรที่ยังไมแหง เพราะจะทําใหกระจกสแกนสกปรกได จึงควรทิ้งไว

ใหแหงกอนสแกน 

จัดเรียงเอกสาร 
เพื่อปองกันปญหากระดาษติด และความเสียหายแกอุปกรณดึงกระดาษอัตโนมัติ กอนสแกนแบบอัตโนมัติ ใหทําดังนี้ 
1. กรีดกระดาษเพื่อไมใหกระดาษติดกัน 
2. เรียงกระดาษใหเปนระเบียบ เทากันทุกดาน โดยทําตามภาพ 
 

 

การใสกระดาษธรรมดา 

1. ใสกระดาษโดยเอาหัวกระดาษลงและคว่ําหนาเขาหาเครื่องสแกนเนอร จัดใหกระดาษอยูตรงกลาง และใสกระดาษจน
ชนกับลูกกลิ้งดานในเครื่อง 

 
 

2. ถาเอกสารยาวเกินไป ใหเปดฝาพลาสติกสําหรับรองกระดาษ เพื่อปองกันไมใหกระดาษงอ 
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3. ปรับที่ก้ันกระดาษใหพอดีกับกระดาษที่ใช  

 

การใสนามบัตร 

1. ใสนามบัตรโดยเอาหัวนามบัตรลงและคว่ําหนาเขาหาเครื่องสแกนเนอร จัดใหนามบัตรอยูตรงกลาง และใสนามบัตร
จนชนกับลูกกลิ้งดานในเครื่อง 

 
2. ปรับที่ก้ันกระดาษใหพอดีกับนามบัตรที่จะสแกน 

** ไมควรใสนามบัตรเพื่อสแกนเกิน 20 ใบ  
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การใสบัตรพลาสติก 

1. ใสบัตรพลาสติกในแนวนอนตามภาพโดยเอาหัวนามบัตรลงและคว่ําหนาเขาหาเครื่องสแกนเนอร จัดใหนามบัตรอยู
ตรงกลาง และใสนามบัตรจนชนกับลูกกลิ้งดานในเครื่อง 

 
2. ปรับที่ก้ันกระดาษใหพอดีกับนามบัตรที่จะสแกน 

** บัตรพลาสติกท่ีสแกนไมควรหนาเกิน 1.2 mm. 

การใสเอกสารที่จะสแกนโดยใช Protection sheet 
ในกรณีที่เอกสารขนาด A3 หรือ ยับ, พับ, ขาด, มวน, รูปทรงที่ไมเปนสี่เหลี่ยม รวมถึงรูปภาพ อาจมีปญหาในการสแกนได 
PS286 PLUS จึงไดมี Protection sheet เพื่อปองกันเอกสารเสียหายและกระดาษติดในเครื่อง 

1. เปดฝาสแกนเนอร 

 
2. ถอด Pad module โดยการกดดานขางทั้งสองแลวดึงออก 

 
3. ปดฝาสแกนเนอรใหเหมือนเดิม 
4. ในกรณีที่สแกนเอกสารขนาด A3 ใหพับครึ่งโดยหันหนาที่จะสแกนออกตามภาพ 
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5. ใสเอกสารใน protection sheet โดยใหชิดดานบนของ protection sheet (ตามเสนสีดํา) 

 
6. เมื่อจะสแกนใหใสเอกสารโดยเอาหัวกระดาษลง (เสนสีดํา) ตามภาพ 

 
7. สําหรับการสแกนหนาเดียว ใหควํ่าหนาเอกสารลง 
 
** เม่ือใช Protection sheet ใหใสเอกสารที่จะสแกนทีละแผนเทานั้น 

 

การสแกนเอกสาร 
 

มีวิธีสแกน 4 วิธี ดังนี้ 
1.   โดยใชโปรแกรมอืนๆที่รองรับ TWAIN interface  

2.   โดยใช DI Capture 
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3.   โดยใช การกดปุมบนตัวเครื่อง 

4.   โดยใช DocAction 
 

TWAIN interface, DI  Capture  และ DocAction จะถูกติดตั้งโดยอัตโนมัติเมื่อทําการติดตั้งไดรเวอรของสแกนเนอร 
 

** หมายเหตุ 
กอนสแกน กรุณาตรวจสอบดังนี้ 
1. คอมพิวเตอรและสแกนเนอรเปดแลว และปลดล็อคหัวอานสแกนเนอรเรียบรอยแลว 

2. ไอคอน ปรากฏอยูบนหนาจอ 
3. ใสกระดาษไวที่ถาดใสเอกสารหรือ flatbed เรียบรอยแลว 

 

การสแกนโดยใช TWAIN Interface  
โปรแกรม TWAIN เ ป นโปรแกรมที่ สํา คัญมากที่ ม าพร อมกับP S 2 8 6  P L U Sโปรแกรมนี้ ทําหนาที่เปนตัวกลาง

ระหวางเครื่องสแกนเนอรและซอฟแวรแกไขภาพ รวมถึงใหคุณปรับการตั้งคาคุณภาพการสแกนได 

เลือกอุปกรณสแกน 

ถาคุณมีสแกนเนอรมากกวา 1 เครื่องติดตั้งอยูแลว คุณจําเปนตองตั้งคาให PS286 PLUS เปนคาเริม่ตน กอนที่จะใชโปรแกรม TWAIN 

1.     สําหรับ NewSoft Presto! ImageFolio:  จาก File menu เลือก Select Source. 
สําหรับ ABBYY  FineReader  6.0  Sprint  Plus:จาก File menu เลือก Select Scanner…. 
สําหรับ HotCard Bizcard Finder : จาก Main toolbar ไปที่ Settings > Acquire Options > Flatbed/TWAIN Scan, 
จากนั้นคลิกที่  Settings > Acquire Options > Select Flatbed/TWAIN Scanner. 

2.   เมื่อมีหนาตางใหเลือกเครื่องสแกนเนอร เลือก PS286 PLUS และคลิกที่ปุม OK เพื่อต้ังเปนคาเริ่มตน 

สแกนดวย NewSoft Presto! ImageFolio: 
1.   คลิกที่ปุม Windows Start แลวเลือกโปรแกรม Presto! ImageFolio 
2.   ในโปรแกรมPresto! ImageFolio คลิก File > Acquire > Acquire 
3.   ในหนาตาง TWAIN เลือก ADF (Front Side) เปนคาในการสแกนหนาเดียว หากคุณตองการสแกนแบบสองหนาให
เลือกที่ ADF (Duplex). 
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4. ปรับแตงคาการสแกน สําหรับการสแกนสองหนา (ADF Duplex)  

4.1. คุณสามารถสแกนเฉพาะดานหนาหรือดานหลังโดยปรับคาการสแกนของดานหนาและดานหลังได โดยคลิกที่ 
Front side หรือ Rear side 

4.2. สามารถใชฟงกช่ัน Merge pages เมื่อเลือกสแกนแบบ ADF (Duplex) และเลือกฟงกช่ัน Automatic size เพื่อ
รวมใหภาพทั้งดานหนาและดานหลังที่สแกนรวมเปนภาพเดียวกัน ซึ่งในฟงกช่ันนี้สามารถเลือกไดวาจะให
ภาพมาตอกันในแนวตั้งหรือแนวนอน   

5. โหลดกระดาษกอน 1 แผน แลวคลิกที่ Preview เมื่อภาพปรากฏขึ้นที่หนาตางการสแกน ก็กําหนดคาตางๆเชน margin  
หรือ crop ไดตามตองการ 

6. จากนั้นโหลดกระดาษทั้งหมดลงไป แลวกดที่ปุมสแกน 
7. เสร็จแลวใหคลิกที่ exit เพื่อออกจากหนาตาง Twain ภาพที่สแกนจะปรากฏโดยโปรแกรม Image folio เพื่อใหทําการ

ดัดแปลงแกไขไดทันที 

 
 

สแกนดวย ABBY FindReader 6.0 Print Plus   
1.   คลิกที่ปุม Windows Start เลือกที่ Programs > ABBYY FineReader 6.0 Sprint Plus และคลิกที่ ABBYY FineReader 

6.0 Sprint Plus  

2.   สแกนหนาเดียวหนาดวย ADF:คลิก  และคลิกทีลู่กศร เลือก Scan Images  

สแกนหลายหนา ดวย ADF:คลิก  และคลิกที่ลูกศร เลือก Scan Multiple Images 
3.   ในหนาตาง TWAIN เลือกการสแกนแบบ ADF Front side ถาตองการสแกนหนาเดียว หรือ ADF Duplex หากตองการ
สแกนสองหนา 
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4.   ต้ังคาการสแกน 
4.1. คุณสามารถสแกนเฉพาะดานหนาหรือดานหลังโดยปรับคาการสแกนของดานหนาและดานหลังได โดยคลิก

ที่ Front side หรือ Rear side 
4.2. สามารถใชฟงกช่ัน Merge pages เมื่อเลือกสแกนแบบ ADF (Duplex) และเลือกฟงกช่ัน Automatic size เพื่อ

รวมใหภาพทั้งดานหนาและดานหลังที่สแกนรวมเปนภาพเดียวกัน ซึ่งในฟงกช่ันนี้สามารถเลือกไดวาจะให
ภาพมาตอกันในแนวตั้งหรือแนวนอน   

5. โหลดกระดาษกอน 1 แผน แลวคลิกที่ Preview เมื่อภาพปรากฏขึ้นที่หนาตางการสแกน ก็กําหนดคาตางๆเชน 
margin  หรือ crop ไดตามตองการ 

6. จากนั้นโหลดกระดาษทั้งหมดลงไป แลวกดที่ปุมสแกน 
7. ภาพที่สแกนไดจะปรากฏในหนาตาง FineReader และจะถูกปรับไปเปนรูปแบบไฟลที่แกไขได หรือเปน PDF 

สแกนดวย HotCard Bizcard Finder   
1. คลิกที่เมนู Start เลือก Programs > Business card Recognition Software แลวคลิกที่ Business card Recognition 

Software เพื่อเปดโปรแกรมขึ้นมา 
2. เมื่อเปดโปรแกรมไดแลว คลิกที่ Main toolbar 
3. เมื่อหนาตาง Twain เปดขึ้น เลือก ADF (Front side) เพื่อเลือกรูปแบบการสแกนนามบัตรแบบหนาเดียว หากตองการ

สแกนแบบสองหนาใหเลือก ADF (Duplex) 
4. ต้ังคาการสแกน (คาเริ่มตนเปน Paper Size: Automatic Size, Resolution: 300)  

4.1. คุณสามารถสแกนเฉพาะดานหนาหรือดานหลังโดยปรับคาการสแกนของดานหนาและดานหลังได โดยคลิก
ที่ Front side หรือ Rear side 

4.2. สามารถใชฟงกช่ัน Merge pages เมื่อเลือกสแกนแบบ ADF (Duplex) และเลือกฟงกช่ัน Automatic size เพื่อ
รวมใหภาพทั้งดานหนาและดานหลังที่สแกนรวมเปนภาพเดียวกัน ซึ่งในฟงกช่ันนี้สามารถเลือกไดวาจะให
ภาพมาตอกันในแนวตั้งหรือแนวนอน   

5. โหลดนามบัตรกอน 1 แผน แลวคลิกที่ Preview เมื่อภาพปรากฏขึ้นที่หนาตางการสแกน ก็กําหนดคาตางๆเชน margin  
หรือ crop ไดตามตองการ 

6. จากนั้นโหลดนามบัตรทั้งหมดลงไป แลวกดที่ปุมสแกน 
7. นามบัตรที่สแกนไดจะปรากฏในหนาตาง HotCard BizCard และจะถูกปรับไปเปนรูปแบบไฟลที่แกไขไดตอไป 
 

การสแกนโดยใช Plustek DI Capture   
1.   คลิกทีปุ่ม Windows Start เพื่อเรียกโปรแกรม DI Capture ขึ้นมา 
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2.   ภายใน DI Capture เลือก PS286 PLUS จากรายการ 

. 

3.    เลือกโฟลเดอร/เอกสารจาก Folder Pane เพื่อเก็บภาพที่สแกนแลว (ในการสรางโฟลเดอรหรือเอกสารใหม ใหคลิก
ที่  New Folder และ/หรือปุม New Document จากทูลบาร) 

4.    เลือกคาการสแกนที่เหมาะสม (อาจจะคลิกที่แท็บ Scan Settings Pane เพื่อตรวจสอบวาคาปจจุบันของ Scan profile 
ตรงกับความตองการหรือไม) ถาไมใหคลิกที่ปุม Create หรือ Manage ขางๆปุม Scan Profile เพื่อสราง profile ใหม
หรือปรับเปลี่ยน profile เดิม) 

5.    คลิกที่ปุม Scan – Append จากทูลบาร 

6.     เมื่อการสแกนเสร็จสิ้น ภาพทั้งหมดจะแสดงบน Browser Pane ภาพสุดทายที่สแกนจะปรากฏอยูใน Viewer Pane. 
 
หรือเพื่อความสะดวกจะคลิกที่ปุม Scan Wizard จากทูลบารเพื่อให Scan Wizard แนะนําขั้นตอนทั้งหมดก็ได 

 

การสแกนดวยการกดปุมที่ตัวเคร่ือง 
เพื่อความสะดวกในการสแกนเอกสาร คุณสามารถตั้งคาการสแกนไดหลายรูปแบบและสแกนโดยการกดปุมที่ตัวเครื่องไดเลย 
โดยการตั้งคาปุมตางๆในการสแกน จะทําผานโปรแกรม DocAction  
 
การต้ังคาการสแกนดวย DocAction 

1. เขาไปที่ DocAction โดยการดับเบิ้ลคลิกที่ไอคอน มุมลางขวาของหนาจอ ตามภาพ 
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2. เลือกหมายเลขที่ตองการตั้งคาการสแกน 

 
 



3. เลือกการตั้งคาที่ตองการไดแก 
3.1. Button template – เปนตัวบอกวาตองการใหปุมนี้เปนอะไร เชน สแกน, OCR, E-mail เปนตน 
3.2. Description – เปนรายละเอียดของ Button template แตละหัวขอ 
3.3. Application – เมื่อสแกนเสร็จแลวใหเปดดวยโปรแกรมอะไร ซึ่งสามารถเพิ่มไดถึง 9 โปรแกรม 

 
3.4. File format – รูปแบบการสแกน  

 

 
 
 
 
 
 
 
 
 
 

คลิกท่ี Add เพ่ือเพ่ิม Application 

ใส Path และรายละเอียด
ของโปรแกรม 

ต้ังคาเพ่ิมเติม 



คูมือการใชงาน PS286 PLUS      
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ซึ่งรูปแบบ File format นี้ ผูใชสามารถกําหนดเองโดยการเลือกจาก Drop down list หรือจะต้ังคาเพิ่มเติม
ก็ได โดยการกดปุม Configure… จะไดหนาจอดังภาพ จากนั้นกําหนดคาตางๆไดเองตามตองการ 

 
3.5. Scan type - รูปแบบการสแกน 

3.5.1. ADF Front side – สแกนอัตโนมัติดานหนา 
3.5.2. ADF Rear side – สแกนอัตโมนัติดานหลัง 
3.5.3. ADF Duplex side – สแกนอัตโมนัติสองหนา 

 
3.6. Page size – ขนาดกระดาษ 
3.7. Scan mode – โหมดการสแกน ไดแก 4 สี, ระดับสีเทา และขาวดํา 
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3.8. Save setup – เปนการระบุวาเมื่อสแกนเอกสารแลวจะใหไปเก็บไวที่ Path ใด 

 
การสแกนที่ตัวเคร่ือง 

1. ใสเอกสาร 
2. กดปุมท่ีตัวเครื่องเพื่อเลือกฟงกช่ันท่ีตองการ 

 
3. กดปุมสแกน 

 
 
เมื่อต้ังคาเสร็จแลวใหคลิกที่ OK เพ่ือปดหนาตาง DocAction และเตรียมเขาสูการสแกนตอไป 
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4. Specification 
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5. Contact us 
บริษัท แวค รีเสิรช จํากัด 
9 ซ.ลาดพราววังหิน 33 ถ.ลาดพราววังหิน แขวงลาดพราว เขตลาดพราว กทม.10230 
โทร.025303809-10, 025381038, 025399352 แฟกซ.025383098 
อีเมล. sales@wacinfotech.com  
Website. www.wacinfotech.com  


